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Xcelsius 2008 Fix Pack 1.2 Release Notes
About these notes

About these notes

These release notes contain information about this release of Xcelsius 2008,
and is cumulative to include information from previous releases of Xcelsius
2008.

Please read the entire document before installing your Business Objects
software. After the release of the software, any late breaking issues will be
added to the Release Notes available online at: http://help.sap.com/con
tent/bobj/overview/index.htm

Please be sure to consult the online release notes to make sure you have
the most up-to-date information.

About Release Numbering

Xcelsius 2008 is the initial release of this product, and may be referred to
unofficially as Xcelsius 2008 RTM.

Xcelsius 2008 SP1 is the first service pack (SP) release and contains a
collection of updates, fixes, enhancements and additional features. Service
packs are considered major releases, and all affected documentation is
updated.

Xcelsius 2008 Fix Pack 1.1 is the first fix pack for SP1 and contains a
collection of patches or bug fixes, but does not contain any enhancements
or additional features. Fix packs are considered minor releases, and
documentation updates are limited to Release Notes and Fixed Issues.

The fix pack numbering is structured as follows: [Service Pack Number].[Fix
Pack Number]. For example, if there were a third fix pack for a fourth service
pack, it would be “Fix Pack 4.3”. Any future Service Packs and Fix Packs
will follow the above outlined numbering system. Fix packs should only be
applied to the service pack they pertain to.

Note:

Users can verify which release of Xcelsius 2008 they have installed from the
Help menu, Help > About Xcesius. The dialog box will display the "Xcelsius
Version" number and the "Build Number". Previous releases correspond to
the following numbers:
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Installation
Xcelsius Release Xcelsius Version Build Number
Xcelsius 2008 (RTM) 5.0.0.99 12,1,0,121
Xcelsius 2008 SP1 5.0.0.99 12,1,0,247
Xcelsius 2008 FixPack [5.1.1.0 12,1,1,344
1.1
Xcelsius 2008 FixPack [5.1.2.0 12,1,2,439
1.2
Starting with the release of Fix Pack 1.1, the "Xcelsius Version" number will
correspond to the Fix Pack numbering structure noted above. The version
number will be structured as follows: [Product Version].[Service Pack
Number].[Fix Pack Number].0.
Installation

Installation Requirements

Xcelsius 2008 requires the ability to write certain files to the registry and
installation directory. If Xcelsius 2008 is unable to gain access and write the
files, it will result in a failure of the installation. Xcelsius 2008 has the following
requirements for these operating systems:

Operating Sys- Requirement

tem

Windows XP Current user must be an Administrator or have Administrator
level rights

Windows Vista « Current user must be an Administrator or have Admin-

istrator level rights
* User Account Control must be disabled

For a complete list of system requirements and supported platforms, see the
platforms.txt file included with your download or media. For complete
installation instructions, see the Installation Guide (xcelsius install <lan
guage>.pdf) included with your download or media.
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Known Issues in Xcelsius 2008 Fix Pack 1.2

Fix Pack Installation Requirements

In order to install a Fix Pack, you must already have the corresponding
Service Pack installed. Fix Packs numbered 1.x require an existing installation
of Service Pack 1 (SP1). Xcelsius 2008 Fix Packs are product version specific
and must only be installed with the correct product version of Xcelsius 2008.
Fix Packs install over the previous installation, do not require a new keycode
and will use the keycode stored from the previous installation of Xcelsius
2008. Fix Packs will install to the installation directory of the corresponding
Service Pack.

Xcelsius 2008 Fix Pack 1.2 is only for installation with the SP1 release of
Xcelsius Engage 2008, Xcelsius Engage Server 2008 or BusinessObjects
Xcelsius Enterprise 2008.

Known Issues in Xcelsius 2008 Fix Pack
1.2

Export Preview

Attempting to perform an Export Preview, while also using an external Excel
file (File > Export Settings > Use Another Excel File), will create an error
and cause Xcelsius to stop responding.

Migrating from Crystal Xcelsius 4.5

Web Connectivity Components - Loading and Idle Messages

Problem: When migrating a Crystal Xcelsius model to Xcelsius 2008, Web
Connectivity components with their Loading and Idle Messages bound to
the Excel spreadsheet, the bound cells for the Loading Message and the
Idle Message will be reversed in the corresponding data connection.

Workaround: Manually type the text into the Property Sheet for the Loading
and Idle Messages prior to migrating to Xcelsius 2008.
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Components

URL Button
When Previewing a visualization or at runtime, the mouse pointer does not

change shape to indicate the presence of a URL link when hovering over
the URL Button component. This behavior differs from Crystal Xcelsius 4.5.

Ignore End Blanks
If "Ilgnore End Blanks" is enabled, and the component is bound to cells

containing formulas that return the value #N/A, then the cells are not treated
as blank and are displayed. This behavior differs from Crystal Xcelsius 4.5.

Connectivity

BusinessObjects Xcelsius Enterprise

Default File Name

Problem: Opening an XLF file from the BusinessObjects Enterprise repository,
then selecting Save or Save As will produce a default file name in the dialog
box of filename.x1f.x1f.

Workaround: Manually remove the extra . x1f from the desired filename.
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Known Issues in Xcelsius 2008 Fix Pack
1.1

Xcelsius Present 2008 - Fix Pack installation error

Problem: Attempting to install Xcelsius 2008 Fix Pack 1.1 produces an error
message in Xcelsius Present 2008.

Solution: Xcelsius 2008 Fix Pack 1.1 is product version specific and must
only be installed with the correct product version of Xcelsius 2008. Xcelsius
2008 Fix Pack 1.1 is only for installation with the SP1 release of Xcelsius
Engage 2008, Xcelsius Engage Server 2008 or BusinessObjects Xcelsius
Enterprise 2008.

Fix Pack 1.1 Language Pack - Installation error
message

Problem: Installing the Language Pack for Xcelsius 2008 Fix Pack 1.1
produces error message.

Workaround: Before installing the Language Pack for Xcelsius 2008 Fix Pack
1.1, you must have previously installed the Language Pack for Xcelsius 2008
SP1.

Xcelsius Panels - Reset display size

Problem: Window or panel may not retain user defined size when entering
and exiting Preview, or closing and restarting Xcelsius.

Workaround: The default window or panel sizes can be re-set to their original
default sizes by deleting the following registry key: HKEY CURRENT USER\Soft
ware\Business Objects\Xcelsius\Settings\en\BCGPDockManager-128.

Caution:
Before making changes to the registry, be sure to back up the registry or
create a system restore point.
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Known Issues in Xcelsius 2008 Fix Pack 1.1

Uninstalling Xcelsius 2008 - Error message

Problem: Attempting to uninstall the main Xcelsius 2008 program, after Fix
Pack 1.1 has been applied, produces an error message in the event the
original Xcelsius 2008 installation folder cannot be located.

Workaround: If Fix Pack 1.1 has been applied, it will be necessary to uninstall
the Fix Pack prior to uninstalling the main Xcelsius 2008 program.

Export Issues

Export to AIR - Embedded SWF files

Embedded SWF files are not supported when using Export to AIR.

Export to AIR - Network locations

Export to AIR does not support the use of network locations. XLF files
exported to AIR format, must be saved to the local machine. Also, all files
used to create the AIR application, such as image files, must be located on
the local machine.

AIR files - Error Message

Problem: Visualizations exported to AIR format produce an error message
and will not run (install).

This is an Adobe security restriction. Xcelsius and non-Xcelsius AIR files will
not run (install) unless the current user has Administrator level priviledges.
For more information, please see article kb403150 on the Adobe website.
http://www.adobe.com/go/kb403150
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Components

Grid Component - Not updating cells

Problem: When migrating a Crystal Xcelsius 4.5 visualization into Xcelsius
2008, the Grid component no longer updates the cells in its Data range during
Preview or in exported visualization.

Workaround: Import the XLF file into Xcelsius 2008, then re-bind the cells in
the Data range of the Grid component.

Listview Component - Row height changes

The Listview component will change the row height, increasing the size of
the display area which automatically adds a scroll bar, if the cells in the
Display Data range are dynamically changed and/or the default label font is
modified. Using non-embedded fonts will minimize the impact of row height
changes to your model layout.

Slider and Progress Bar - Text alignment

Problem: When migrating a Crystal Xcelsius 4.5 visualization into Xcelsius
2008, Vertical Sliders and Vertical Progress Bar components do not maintain
alignment/offset of the Title and Value text elements when they are positioned
in line with each other (e.g. Title position is Top Left and Value position is
Top Right).

Workaround: Import the visualization into Xcelsius 2008, then correct the
alignment by manually adjusting the Offset for the Title and Value text
elements.

Source Data Component - Error on load

Upon load, the Source Data component does not insert data into the
Destination cell. Using a selector or single value component to manipulate
the Selected Item Index will update the value and the Souce Data component
will then function as expected.

Xcelsius 2008 Fix Pack 1.2 Release Notes 9



Xcelsius 2008 Fix Pack 1.2 Release Notes
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Dynamic Visibility Conflict - Error #1009

This error message is caused by a conflict with the Dynamic Visibility. The
Status cell selection used to determine Dynamic Visibility cannot be any of
the cells that the component modifies, for example the Data or Destination
ranges.

Connectivity

XML Maps - New additional data not retrieved

When components are bound to a cell range that is larger than the XML
Maps data range, to accommodate additional data, they do not update when
XML data is added by new rows and/or columns.

Microsoft Excel

Excel 2007 - Nested formulas

Problem: Microsoft Excel 2007 users are able to nest more than seven
functions in a formula. However, when imported into Xcelsius 2008, formulas
with more than seven functions nested are returned as #N/A.

Xcelsius 2008 is not able to support more than seven nested functions in a
formula.

Microsoft Office XP - Hyperlinks in embedded spreadsheet

Problem: Microsoft Office XP users, who also have Live Office installed, find
that after inserting a hyperlink into a cell that the embedded spreadsheet
stops responding.

Workaround: There is no workaround for this issue. Microsoft XP users, with
Live Office installed, should avoid use of hyperlinks in the embedded
spreadsheet.
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What's New in Xcelsius 2008 SP1

Local Scenarios - Adobe Acrobat 9

When exported to Adobe Acrobat 9, visualizations with a "Local Scenario
Button" component will be able to store scenarios within the SWF file. When
the PDF, with embedded SWF, file is shared with others, the previously
created scenarios are retained and can be viewed at runtime. Users with the
full version of Acrobat 9 will be able to run the SWF file, and then save, load
or delete scenarios. Users with the Reader version of Acrobat 9 will only be
able to load any previously saved scenarios from the SWF file.

Export to Adobe PDF

When exporting to Adobe PDF format, using File > Export > PDF you will
be able to choose which version of Adobe Acrobat (Acrobat 6 for PDF 1.5,
or Acrobat 9 for PDF 1.8) to use. When exporting to PDF using the toolbar
button, the exported document will be in Acrobat 6 format.

There is a typographical error in the User Guide which states there are
different default Acrobat versions when using the Export to PDF toolbar
button for Xcelsius Present and Xcelsius Engage versions. All versions of
Xcelsius 2008 default to Adobe Acrobat 6 for Export to PDF using the toolbar
button.

Connection Refresh Button - Refresh On Load

Data connections using the option Refresh On Load will retrieve data upon
previewing or launching the visualization. The data retrieved upon load will
be become the default state of the visualization. To trigger a refresh of the
data of the immediately after loading, the "Connection Refresh Button" now
also has a Refresh On Load option. The data retrieved from this refresh,
immediately after loading, will not be used as the default state of the
visualization.
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Microsoft Excel - Additional Supported Functions

The following Microsoft Excel functions have been added to the functions
supported by Xcelsius 2008:

ISERR
ISERROR
ISEVEN
ISLOGICAL
ISNONTEXT
ISODD
ISTEXT
TYPE

Known Issues in Xcelsius 2008 SP1

Launching Xcelsius 2008 - Error Message

If you receive an error message when attempting to launch Xcelsius 2008,
it may be caused by a rogue Microsoft Excel process. You will need to open
the "Windows Task Manager" and end the running Excel process before
attempting to restart Xcelsius 2008. Press theCTRL + ALT + DEL keys
simultaneously. Click on Task Manager. Click Processes tab. Find and
highlight the EXCEL.EXE process. Click End Process. The "Task Manager
Warning" dialog box will appear, click Yes to confirm. Exit the "Windows
Task Manager". Launch Xcelsius 2008.
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Known Issues in Xcelsius 2008 SP1

"Server Busy" Dialog Box

If a component's Dynamic Visibility is enabled, switching between the canvas
and the embedded spreadsheet may cause the application to hang. If so,
please wait. If the "Server Busy" dialog box appears, please press the Cancel
button. This should return user control.

Adobe Flash Player - Security Changes

The Adobe Flash Player 8 and 9 have introduced significant security changes.
These security measures will have an impact on user workflow with Xcelsius
2008. The new security changes will affect the design time experience, as
well as the exported SWF experience. Specifically, the changes affect SWF
files that call content files stored on a local drive. SWF files attempting to
call content files (images, XML data, etc.), using a URL file reference, will
not be able to deliver the content unless the local drive has been listed as a
trusted location in the Adobe Flash Player security settings. This may occur
if you "Snapshot" or "Export" to a local format such as PPT, HTML or Word
and try to run the SWF file.

You will need to change the Adobe Flash Player security settings to allow
the local drive to be trusted. To enable trust:

1. Go to http://www.macromedia.com/support/documentation/en/flashplay
er/help/settings_manager04.html
2. Click Always Allow

3. In the Always trust files in these locations: drop down, select Add
location...

4. Browse for the location of your SWF file.

Following are the links for documentation about security changes
implemented after Adobe Flash Player 7. Flash Player documentation is
version specific and does not address previous versions. Users with Adobe
Flash Player 9 will need to read both sets of documentation.

Security Changes in Flash Player 8http.//www.adobe.com/devnet/flash/arti
cles/fplayer8_security.html

Security Changes in Flash Player 9http.//www.adobe.com/devnet/flashplay
er/articles/fplayer9 _security.html
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Export Issues

Flash Player Error Number or Messages

Problem: While running an Xcelsius SWF file, error numbers or messages
may be shown. These are generated by the Adobe Flash Player.

Workaround: The definitions for the Adobe Flash Player errors are given
online at:

http://livedocs.adobe.com/flex/2/langref/runtimeErrors.html

Hosted SWEF files - Cross Domain Policy File

If your SWF is hosted on a web server, any web server that your SWF file
connects to for live data needs to have a cross domain policy file in the web
server root (differs for each web server). Without a cross domain policy file,
the SWF file may not be able to connect to the web server to get data.

For security reasons, the Adobe Flash Player is not allowed to access data
that resides outside the exact web domain from which the SWF originated.
Various error messages may be displayed but the most common is unable
to Load URL: http://boe-server:8080/dswsbobje/services/session

A cross domain policy file is a simple XML file that gives the Adobe Flash
Player permission to access data in a given domain without displaying a
security dialog. The cross domain policy file on your web server controls
which SWF files, running on which domains, can access your web server.
When placed in a root folder of a server, it tells the Flash Player to allow
direct access to data on that server, without prompting the user to grant
access. Either download or create a crossdomain.xml file and place it in
the root folder of all necessary servers to allow the Adobe Flash Player used
by Xcelsius 2008 access across domains.

For example, for use between different BusinessObjects Enterprise servers,
the crossdomain.xml should go in the associated Tomcat folders on each
server. Location: c:\Program Files\Business
Objects\Tomcat\webapps\ROOT.
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Here is an example of a cross domain policy file that allows any SWF, running
on any domain, access to your web server. This file needs to be placed in
the root folder of your web server:

<?xml version="1.0"?>
<!DOCTYPE cross-domain-policy SYSTEM
"http://www.macromedia.com/xml/dtds/cross-domain-policy.dtd

||>

<cross-domain-policy>

<allow-http-request-headers-from domain="*" headers="*" se

cure="false" />

<allow-access-from domain="*" secure="false" />

</cross-domain-policy>

For more information on cross domain policy files, please see the Adobe
website.

Export Issues

* When exported to PDF format, SWF files with data sources that use URL
schemes other than http:// or https:// are not supported.

*  SWEF files with apostrophes in their file names do not open properly in
Internet Explorer version 6. Ensure that the file name of the SWF file does
not have apostrophes in it.

Export to Word or PowerPoint - Blank Document

Problem: "Snapshot" or "Export" to Word or PowerPoint shows a blank or
inactive document. This is an Adobe Flash Player issue.

Workarounds:

For Word documents, exit Design Mode by clicking the Exit Design Mode
icon, on the "Control Toolbox" toolbar. Then right-click on the embedded
SWEF file and select Play to display the SWF file properly.

For PowerPoint slides, slideshows by default are in Normal view. Switch
from Normal view to the Slide Show view. After switching views, right click
the embedded SWF file and select Play. The SWF file should now display
properly in Normal view.
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Export to Microsoft Word 2007 and PowerPoint 2007

File formats with extensions .docx and .pptx do not support embedded
Adobe Flash files. Users with Microsoft Office 2007 applications installed
will need to save their visualizations exported to Word 2007 to file type .doc
and files exported PowerPoint 2007 to file type .ppt.

Export to Microsoft Word 2007 - Macro Error

Problem: If macro support is not enabled in Microsoft Word 2007, a dialog
box opens with the message: The function you are attempting to run
contains macros or content that requires macro language
support. .. This dialog box can be difficult to detect as it opens behind
Xcelsius 2008 and without a taskbar listing. To view the dialog box and close
it, use ALT + TAB to switch windows.

Workaround: Enable Word 2007 macro support. Then re-export the Xcelsius
2008 visualization to Word. An apparently blank document will be exported.
Exit Design Mode by clicking the Exit Design Mode icon, on the "Control
Toolbox" toolbar. Then right-click on the embedded SWF and select Play to
display the SWF file properly.

Export to AIR - International Characters

"Export to AIR" does not support international characters in the Name, ID or
Destination fields. Per Adobe, only Western characters are supported.

Components

Charts - Non-numeric Data

Binding a chart's data set to text based data (as opposed to numerical data)
produces no change in the chart's display. If a chart's data set is bound only
to text based data, the data set will not be recognized as valid and the default
data of the chart will continue to be displayed. Chart data must be numerical.
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Container Components - Limitations

Grouping tabs

The "Tab Container" component functions as a single grouping of the tabs
within the component. Creating sub-groups of the tabs within the component
is not supported.

Nesting Container components

Container components can be nested within each other to create multi-layer
dashboards. Xcelsius 2008 best practices recommends using only one layer
of nesting, e.g. a parent "Tab Container”, with a child "Tab Container” on

each tab (no Container components within the children). Further nesting of
Container components may decrease the performance of the visualization.

Snapshot - History component

When a Snapshot is taken of a visualization, only the most recent data point
is recorded by the "History" component.

Example: Your visualization has a "History" component that inserts data in
a range of 6 cells, and the visualization has a "Spreadsheet Table" displaying
that same range of 6 cells. In any type of Snapshot, the "Spreadsheet Table"
will only display the last, or most recent, data point recorded by the "History"
component in the first cell of the range and the other 5 cells will be blank.

Connectivity

FSCommand - Supported Parameters

Some uses of Adobe's Fscommand action are not supported in the Adobe
Flash Player 9. Although Fscommand can not be used to pass commands to
the Flash Player directly, it can be used communicate with the program
hosting the player or pass messages to Macromedia Director, Visual Basic,
Visual C++, and other programs that can host ActiveX controls.
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SAP Data

The six predefined Fscommand commands that are used to manipulate SWF
files within the Flash Player do not currently function. This is a known issue
to be resolved by Adobe. Xcelsius 2008 supports the use of the FsCommand
action to pass commands and parameters to a scripting language, such as
JavaScript, in a Web browser.

FSCommand can also be used to send messages to Macromedia Director or
Visual Basic events to programs that can host ActiveX controls. These uses
may be functional in Xcelsius 2008, however they are not officially supported.

For more information on this topic, please see the Adobe article at:
http.//www.adobe.com/support/flash/action_scripts/actionscript_dictionary/ac
tionscript_dictionary372.html.

Sources - Weblntelligence Query

Passing Weblntelligence query prompt values through a Live Office
connection in Xcelsius 2008 to an SAP data source does not return any
output. The ability to query an SAP data source is currently not supported,
but may be added as an enhancement for a future release.

Deployment in Windows and Unix using Vintela AD

Problem: A general error of http 404 occurs when attempting to view SWF
files in BusinessObjects Enterprise InfoView. This occurs when attempting
to use Vintela AD Single Sign On (SSO) on UNIX and Windows for connecting
to BusinessObjects Enterprise.

Workaround: Xcelsius 2008 does not currently support this environment.

Xcelsius Engage Server 2008

Xcelsius Reporting Services

* Reporting Services data sources and reports that are configured to prompt
the user for credentials at report runtime are not supported.

* A Reporting Services report that contains a manually entered parameter
with a null default value must have a parameter entered in the Link to
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Cell field of the Reporting Services Button before the data can be
mapped.

Reports containing Multiple Selection parameters in Reporting Services
are not supported.

Installing SharePoint Server 2007

Problem: The current Xcelsius 2008 web part installer setup.exe does not
support SharePoint Server 2007.

Note:
SharePoint Portal Server 2003 is supported.

Workaround: You can manually install the web part for Microsoft SharePoint
Server 2007. Microsoft does not provide a mechanism to build a web part
installer for SharePoint Server 2007.

Xcelsius SharePoint Web Part

When using the ListBox parameter type for SharePoint, a data range of
two columns must be selected within the Entries field. The values in the
first column appear in a list box within SharePoint and depending on what
selection is made from this list, the corresponding values from the second
column are inserted into the range.

Flashvar range names and SharePoint parameter names cannot be any
Flash keywords or reserved words.

For a table of Flash keywords and reserved words, go to:
http://livedocs.adobe.com/flash/mx2004/main_7 _2/00000767.html
For an overview of this topic, go to:
http://livedocs.adobe.com/flash/9.0/main/00000697.html

SharePoint ("Portal Data") connection with Connection Type:None: When
linking a date parameter to a blank cell, the date December 31, 1899 is
used by default. This date is used because it is the Julian date
representation of the value 0. Therefore, when linking a date parameter
to a cell, populate it with your required default date.
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BusinessObjects Xcelsius Enterprise 2008

Live Office

Version Compatibility with Live Office

In order for Xcelsius 2008 to be compatible with Live Office connected to
BusinessObjects Enterprise, both Live Office and Business Objects Enterprise
must be of the same release and version number. For example, Live Office
XI 3.0 must be connected to BusinessObjects Enterprise XI 3.0.

Note:
After being imported in a spreadsheet, data connections created in a previous
version of Live Office cannot be edited or updated.

If you have both Live Office XI 3.0 and Live Office XI R2 installed, then you
must select which one to use in Microsoft Excel through the "Add-Ins" menu.

Xcelsius 2008 and Live Office

Note:

The Live Office application may not provide the full functionality from within
Xcelsius 2008 as is provided from within Microsoft Office applications. Some
Live Office functions which are not supported from within Xcelsius 2008 are:
modifying Live Office object properties, including refresh options; opening
published spreadsheets from BusinessObjects Enterprise; and publishing
spreadsheets to BusinessObjects Enterprise. It is recommended to utilize
Live Office functionality in Microsoft Excel, then import the Live Office-enabled
spreadsheet into Xcelsius 2008.

Toolbar buttons disabled

The Refresh All and Go to Object buttons on the Live Office toolbar will
not be enabled after inserting a Live Office object into the embedded
spreadsheet within Xcelsius 2008.

Unspecified error message

Users may receive an Unspecified error when attempting to navigate to
a Live Office object using the Go to Object button. This may result if an
exception occurred during insertion of the object and Live Office
Compatibility Mode was not enabled.
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Export embedded spreadsheet with Live Office object

Live Office objects inserted into the embedded spreadsheet within Xcelsius
2008, may become invalid when the spreadsheet is exported to Microsoft
Excel.

Context menu does not appear

The context menu that appears upon right-click of the mouse, may not show
the Live Office menu when right-clicking on a Live Office object within Xcelsius
2008.

Live Office toolbar - Microsoft Office XP and Office 2003

Microsoft Office XP and Office 2003 users, when importing a spreadsheet

that contains Live Office objects, only one LiveOffice toolbar button, “Open
from BusinessObjects Enterprise”, will be enabled in the Xcelsius 2008

embedded spreadsheet.

Live Office

*  When importing a Crystal Xcelsius 4.5 XLF file containing a "Live Office
Connector", only the Views that were active will automatically be created
in the "Data Manager" of Xcelsius 2008. The inactive Views can be
accessed by following the steps to add a Live Office connection in the
"Data Manager". Please see the User Guide for more information on
adding Live Office connections.

*  OLAP objects are not supported as a data source.

» If you create a Live Office-enabled SWF file using an object that contains
merged cells, the merged cells may not be displayed the same as from
within the source report.

* A Live Office-enabled SWF file using a Crystal Report that requires
database logon credentials will fail to refresh. This occurs because the
SWEF file does not prompt the user for database logon credentials, even
if required by the report.

To ensure the data is refreshed properly, the SWF file and the Crystal
Report must be saved to the same BusinessObjects Enterprise system.
A BusinessObijects Enterprise administrator must then enter the report's
database logon information in the Central Management Console so that
credentials are not required when the report is refreshed.

+ If a Live Office-enabled SWF file is created using a Web Intelligence
document, the query context that is entered by users within the SWF file
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is not used to trigger the refresh. Instead, the query context saved from
the last Live Office refresh will be used to trigger the refresh.

» Live Office-enabled SWF files only use parameters and prompts bound
to spreadsheet cells to trigger a refresh. Parameters or prompts that are
not bound to spreadsheet cells are ignored by the SWF file. Instead, the
SWEF file uses the parameter or prompt values from the last Live Office
refresh. To ensure the SWF file uses the correct values to trigger a refresh,
bind parameters and prompts to cells in the Microsoft Excel spreadsheet.

* Onrefresh, Live Office-enabled SWF files created with content based on
a Universe will not retrieve Universe data that has been changed since
the SWF file was opened. In order to view updated Universe data, you
will need to close the SWF file and re-open it.

» In an XLF file, an existing Live Office connection can be opened and
modified by a user who does not have Live Office installed on their local
machine. However, to add a new Live Office connection, the user must
have Live Office installed.

»  Xcelsius 2008 users who have both Microsoft Excel 2003 and 2007 will
notice that the Live Office toolbar in Excel 2003 has fewer buttons and
features than the Live Office ribbon in Excel 2007. This is by design.

Live Office Compatibility Mode

If you have enabled "Live Office Compatibility Mode", you may experience
some unexpected behaviors with other Microsoft applications that persist
after Xcelsius 2008 is closed; e.g. double-click on file icon does not open file
as expected. It is recommended to disable "Live Office Compatibility Mode"
before closing Xcelsius 2008.

Live Office toolbar disappears

Problem: Due to issues with Microsoft Excel itself, on rare occasions the
Live Office toolbar may disappear from the Excel toolbars in Xcelsius 2008.

Workaround: If the toolbar has unexpectedly disappeared, the Live Office
toolbar and menu can be re-enabled by running a Live Office utility. The
utility can be found at Program Files\Business Objects\Live Office
12.0\enable addin.exe.

Tip:
The utility can re-enable the menu in Excel, as well as for Word, Outlook,
PowerPoint.
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Viewing Parent SWF Hosted in BusinessObjects Enterprise InfoView
with Local Child content

Problem: Exporting a SWF (parent) to BusinessObjects Enterprise that has
local content (e.g. a child swf, or image) stored on a local PC. The parent
SWF can be viewed in InfoView but it cannot load the child content.

Workaround: There is no workaround for this. This is an Adobe security
restriction. The Adobe Flash Player 9 does not allow a SWF hosted on a
URL (i.e. BusinessObjects Enterprise InfoView or a website) to load a file
that is stored on a local file system. Parent SWF files hosted in
BusinessObijects Enterprise InfoView must have child content that is also
hosted in BusinessObjects Enterprise InfoView.

Please see the following document from Adobe for more information: Security
Changes in Flash Player Qhttp://www.adobe.com/devnet/flashplayer/arti
cles/fplayer9 _security.html

Related Topics
» Adobe Flash Player — Security Changes on page 13

Query As A Web Service (QaaWs)

+  Xcelsius 2008 is compatible with all versions of QaaWsS for
BusinessObjects Enterprise XI R2 (updated to the latest FixPacks), XI
3.0 and XI 3.1.

+ Beginning with BusinessObjects Enterprise Xl 3.0, in order to use the
latest version of QaaWS with Xcelsius 2008, you must download the latest
version of the client application for BusinessObjects Enterprise and install
it on your client machine. You may or may not have access to this
download depending on the licensing agreement you have with Business
Objects.

Note:
The client application for BusinessObjects Enterprise Xl 3.0 is
approximately 600MB in size.

+  WSDLs generated by Query as a Web Service should be consumed by
a "QaaWs Connection ".

+  WSDLs that use DIME and other binary formats are not supported.

»  WSDLs that contain overloaded method are not supported.
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*  On refresh, SWF files created with a QaaWS connection to a Universe
will not retrieve Universe data that has been changed since the SWF file
was opened. In order to view updated Universe data, you will need to
close the SWF file and re-open it.

SAP Authentication for BusinessObjects Enterprise

Problem: The Xcelsius 2008"Open/Import from Enterprise" menus do not
have SAP Authentication as an option.

Workaround: In order to interface with SAP products, you will need to install
a separate product, the SAP Integration Kit.

Logging into BusinessObjects Enterprise with Windows AD
authentication

Xcelsius 2008 users attempting to logon to the BusinessObjects Enterprise
platform using “Windows AD” authentication to perform one of the below
listed actions will be prompted with the following error message: security
plugin error: An error has occurred in the plugin, but the
plugin is unable to return a detailed error message.

These actions include:
+ Open from Enterprise (for Xcelsius files (XLF))
+ Save to Enterprise (for Xcelsius files (XLF))

» Export to Business Objects Platform (for exporting Xcelsius generated
Adobe Flash files (SWF))

* Import from Enterprise (for Microsoft Excel files (XLS / XLSX))

Workaround: Either of the following workarounds can be used:

» Create Enterprise aliases for users and have them login via Enterprise.
» Create LDAP - AD aliases for users and have them login via LDAP.
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Microsoft Excel

Microsoft Excel Functions - Known Issues

Array Formulas (entered using Ctrl + Shift + Enter)
Issue: Xcelsius 2008 does not support Microsoft Excel array formulas.

Condition: Formula is an array formula, entered using Ctrl + Shift
+ Enter, enclosed between braces {} e.g. ={suM(B2:D2*B3:D3) }.

Behavior: Incorrect calculation is returned by Xcelsius 2008.

DATEVALUE(date_text)
Issue: Xcelsius 2008 does not support Microsoft Excel's internal
text-based date format.

Condition: Date_text is entered in non-numeric format, e.g. January
1, 2008.

Behavior: Xcelsius 2008 will return #VALUE!. Excel will return its
internal date value.
Functions with “optional” parameters

For Excel functions that have parameters which are optional, or have
values that can be omitted, it is recommended to provide values for
these parameters. Omitting values for optional parameters may
prevent your visualization from rendering.

INDEX(array, row_num, column_num)

Issue: Xcelsius 2008 calculates INDEX as a value, not a cell
reference. Therefore, it cannot be combined with other functions that
use cell references.

Condition: Other functions combined with INDEX requiring a cell
reference, i.e. SUM (A1 : INDEX (...)).

Behavior: Xcelsius 2008 calculates a value, creating an error for
other functions that use cell references.

IRR(values, guess)

Issue: Xcelsius 2008 returns incorrect calculation if the guess value
is negative.

Condition: Guess value is negative.
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Behavior: Xcelsius 2008 returns blank. Excel returns a valid IRR
value.

SUMIF(range, criteria, sum_range)
Issue: Xcelsius 2008 does not calculate an expanded sum_range if
range cell selection is larger than sum_range cell selection.

Condition: Range cell selection is larger than sum_range cell
selection.

Behavior: Xcelsius 2008 only calculates cells selected in the
sum_range; Excel calculates an expanded sum_range based on the
larger cell selection of range.

TEXT(value, format_text)

Issue: Xcelsius 2008 doesn't support formatting Excel internal
numbering scheme into year.

Condition: Value is between Excel's minimum and maximum year
(in number form); format_text value is e.

Behavior: The formula =TexT (1, “e”) Xcelsius 2008 returns e; Excel
returns value 1900.

VLOOKUP(lookup_value, table_array, col_index_num,
range_lookup) and
HLOOKUP(lookup_value, table_array, row_index_num,
range_lookup)
Issue: Microsoft Excel and Xcelsius 2008 produce different
calculation results on duplicated lookup_value in table_array.
Microsoft has reported a known issue with these functions.

Conditions:

- Range_lookup value is omitted or set to TRUE.
- Lookup_value in table_array is duplicated (two or more times).

- The values in the first column oftable_array are sorted in ascending
order.

Behavior: Xcelsius 2008 will return the value from the FIRST
row/column found in the table_array; Excel will return the value from
the LAST row/column in the table_array.

26 Xcelsius 2008 Fix Pack 1.2 Release Notes



Xcelsius 2008 Fix Pack 1.2 Release Notes
Known Issues in Xcelsius 2008 SP1

Embedded spreadsheet - worksheet references in formulas

Problem: Referencing a cell in an adjacent worksheet displays an improper
cell reference.

Within the embedded spreadsheet of Xcelsius 2008, if while creating a
formula the user mouse-clicks to reference a cell in another worksheet within
the same workbook, the cell reference will be displayed incorrectly.

For example, the formula in cell A1 of Sheet1 should reference cell A1 of
Sheet2. Typing the = character in cell A1 of Sheet1, navigating to Sheet2,
and then clicking cell A1 of Sheet 2 will produce the following:

In Microsoft Excel (correct): =Sheet2!A1
In Xcelsius 2008 (incorrect): =Sheet2!Sheet2!A1

Workaround: User will need to either manually type the formula or delete the
duplicate worksheet references from the completed formula.

Migrating from Crystal Xcelsius 4.5

Migrating External Data Connectors

When importing an XLF file created in Crystal Xcelsius 4.5 containing an
external data connector ("XML Data Button", "XML Map Refresh", "Web
Service Connector”, "Live Office", "FS Command"), the following actions
occur for each connector or button:

» Aconnection is created in the "Data Manager" with the previous "Refresh
Options" and "Load Status" settings

»  "Trigger Behavior" settings are mapped to a separate "Connection Refresh
Button" that is automatically created
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Documentation Addendum

Dual Axis feature in Charts

The following components have the Dual Axis feature available: "Line Chart",
"Bar Chart", "Column Chart", and "Area Chart". A typographical error in the
User Guide lists additional chart components as having the Dual Axis feature
available, however they do not.

When Cell Updates - Option Removed

The When Cell Updates option has been removed from Xcelsius 2008.

These areas are affected by the change:

- Data Manager > Query as a Web Service > Usage tab > Refresh
Options > Refresh on Trigger

- Data Manager > Web Service Connection > Usage tab > Refresh
Options > Refresh on Trigger
Data Manager > XML Data > Usage tab > Refresh Options > Refresh
on Trigger

- Data Manager > FS Command > Usage tab > Provider Options >
Communicate on Trigger

- Data Manager > Excel XML Maps > Usage tab > Refresh Options >
Refresh on Trigger

- Data Manager > Live Office Connections > Usage tab > Refresh
Options > Refresh on Trigger
URL Button properties panel > Behavior tab > Common tab > Trigger
Behavior

+ Connection Refresh Button properties panel > Behavior tab >
Common tab > Trigger Behavior

* Reporting Services Button properties panel > Behavior tab >
Common tab > Trigger Behavior
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Using the Data Manager - Xcelsius Engage

Xcelsius Engage supports multiple connections in a single visualization, but
only one (1) connection of each of the following connection types: "Web
Service", "XML Data", "FlashVars", and "Crystal Reports Data Consumer".
After one of these connection types has been added, no additional
connections of that type can be added to the visualization.

Selector Components - Xcelsius Present

Typographical errors in the Xcelsius 2008 User Guide indicate that the List
View and Ticker components are not included with Xcelsius Present. This
should be corrected to indicate these components are included with all
versions of Xcelsius 2008.
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